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1 Introduction And Scope

Reflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which
employs a workflow engine to provide a real-time visual representation of a data reduction cascade, called a
workflow, which can be easily understood by most astronomers. The basic philosophy and concepts of Reflex
have been discussed by Freudling et al. (2013A&A...559A..96F). Please reference this article if you use Reflex
in a scientific publication.

Reflex and the data reduction workflows have been developed by ESO and instrument consortia and they are
fully supported. If you have any issue, please contact usd-help@eso.org for further support.

This document is a tutorial designed to enable the user to employ the KMOS workflow to reduce his/her data in
a user-friendly way, concentrating on high-level issues such as data reduction quality and signal-to-noise (S/N)
optimisation.

A workflow accepts science and calibration data, as delivered to PIs in the form of PI-Packs (until October
2011) or downloaded from the archive using the CalSelector tool1 and organises them into DataSets, where each
DataSet contains one science object observation (possibly consisting of several science files) and all associated
raw and static calibrations required for a successful data reduction. The data organisation process is fully
automatic, which is a major time-saving feature provided by the software. The DataSets selected by the user
for reduction are fed to the workflow which executes the relevant pipeline recipes (or stages) in the correct
order. Full control of the various recipe parameters is available within the workflow, and the workflow deals
automatically with optional recipe inputs via built-in conditional branches. Additionally, the workflow stores the
reduced final data products in a logically organised directory structure employing user-configurable file names.

This tutorial deals with the reduction of KMOS IFU observations only via the KMOS Reflex workflow. The
user is referred to the KMOS user manual (Cirasuolo 32). More information on the instrument itself as well as
a summary of available documentation, recent news, and tools, can be found at the ESO instrument web pages
3. A brief description of the KMOS data flow is given in Davies 24)

The quick start section (see Section 5) describes the minimum effort to get started, and it makes up only two
pages of text in this tutorial. User support for this software is available by sending enquiries to usd-help@eso.org.

1http://www.eso.org/sci/archive/calselectorInfo.html
2available at: http://www.eso.org/sci/facilities/paranal/instruments/kmos/doc
3http://www.eso.org/sci/facilities/develop/instruments/kmos.html
4available at: http://www.mpe.mpg.de/389507/davies-7735-254x.pdf

mailto:usd-help@eso.org
http://www.eso.org/sci/archive/calselectorInfo.html


ESO Reflex KMOS Tutorial
Doc: VLT-MAN-ESO-19500-....
Issue: Issue 1.2
Date: Date 2015-03-24
Page: 8 of 35

2 Workflow Status
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3 Software Installation

The software pre-requisites for Reflex 2.6 may be found at:
http://www.eso.org/sci/software/pipelines/reflex_workflows

To install the Reflex 2.6 software and demo data, please follow these instructions:

1. From any directory, download the installation script:

wget ftp://ftp.eso.org/pub/dfs/reflex/install_esoreflex

2. Make the installation script executable:

chmod u+x install_esoreflex

3. Execute the installation script:

./install_esoreflex

and the script will ask you to specify three directories: the download directory <download_dir>, the
software installation directory <install_dir>, and the directory to be used to store the demo data
<data_dir>. If you do not specify these directories, then the installation script will create them in the
current directory with default names.

4. You will be asked whether you want to use your Internet connection. Unless you want to reuse already
downloaded packages (only advanced users), use the default Yes.

5. You will be given a choice of pipelines (with the corresponding workflows) to install. Please specify the
numbers for the pipelines you require, separated by a space, or type “A” for all pipelines.

6. For the pipelines to be installed you will be prompted for the demo data sets to be installed. Type “A” for
all demo datasets. Take into account that if you are installing in a directory that already contains data, it
won’t be removed.

7. The script will also detect whether previous versions of the workflows or Reflex were installed and in this
case you have the option to update links or remove obsolete cache directories. It is advised to use the
defaults.

8. To start Reflex, issue the command:

<install_dir>/bin/esoreflex

It may also be desirable to set up an alias command for starting the Reflex software, using the shell com-
mand alias. Alternatively, the PATH variable can be updated to contain the <install_dir>/bin
directory.

http://www.eso.org/sci/software/pipelines/reflex_workflows
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4 Demo Data

Together with the pipeline you will also recieve a demo data set, that allows you to run the Reflex KMOS
workflow without any changes in parameters. This way you have a data set to experiment with before you start
to work on your own data.

Note that you will need a minimum of ∼5 GB, ∼9 GB and ∼2.5 GB of free disk space for the directories
<download_dir>, <install_dir> and <data_dir>, respectively.

The raw input consists of a single SCIENCE OB of the HII, star-formation region Gum 43 (RCW 65) executed
in NOD to SKY mode, and includes the raw calibration frames: darks, lamp flats, arc lamps, and flux standards.
The static calibration files (arc line lists, atmosphere model, OH spectral lines, and arc reference lines) are
included in the pipeline distribution. The raw tutorial data set is summarized in table 4.1.

Table 4.1: The KMOS Reflex workflow tutorial data set

File DPR.CATG DPR.TYPE INS.GRAT1.ID DET.SEQ1.DIT
KMOS.2013-06-27T02:30:02.036.fits CALIB FLAT,OFF K 3.0000000
KMOS.2013-06-27T02:30:13.935.fits CALIB FLAT,OFF K 3.0000000
KMOS.2013-06-27T02:30:26.009.fits CALIB FLAT,OFF K 3.0000000
KMOS.2013-06-27T02:33:25.442.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:33:37.272.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:33:49.244.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:34:42.585.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:34:54.500.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:35:06.539.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:35:59.909.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:36:11.744.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:36:23.588.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:37:17.002.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:37:27.878.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:37:40.018.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:38:33.399.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:38:45.321.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:38:57.219.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:39:50.556.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:40:02.535.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:40:14.442.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:42:34.927.fits CALIB WAVE,OFF K 4.0000000
KMOS.2013-06-27T02:45:31.613.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:46:24.832.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:47:18.086.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:48:12.603.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:49:06.959.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:50:01.906.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-28T22:21:22.894.fits CALIB FLAT,SKY K 5.0000000
KMOS.2013-06-28T22:21:57.131.fits CALIB FLAT,SKY K 30.0000000
KMOS.2013-06-28T22:22:36.403.fits CALIB FLAT,SKY K 30.0000000
KMOS.2013-06-28T22:23:14.587.fits CALIB FLAT,SKY K 30.0000000
KMOS.2013-06-29T05:25:36.594.fits CALIB OBJECT,SKY,STD,FLUX K 10.0000000
KMOS.2013-06-29T05:26:08.050.fits CALIB OBJECT,SKY,STD,FLUX K 10.0000000
KMOS.2013-06-29T05:26:34.039.fits CALIB OBJECT,SKY,STD,FLUX K 10.0000000
KMOS.2013-06-30T14:52:42.168.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:54:30.888.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:56:19.580.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:58:08.242.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:59:56.907.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T23:48:06.049.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-06-30T23:53:23.571.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-06-30T23:59:09.586.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:04:22.390.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:09:35.560.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:14:52.379.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:20:10.285.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:25:24.507.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:30:37.274.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:35:55.867.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:41:13.785.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:46:26.588.fits SCIENCE OBJECT,SKY K 300.0000000
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5 Quick Start: Reducing The Demo Data

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe
the steps to be performed to reduce the science data provided in the KMOS demo data set supplied with the
Reflex 2.6 release. By following these steps, the user should have enough information to attempt a reduction
of his/her own data without any further reading:

Figure 5.1: The empty Reflex canvas.

1. Start the Reflex application:

reflex &

The empty Reflex canvas as shown in Figure 5.1 will appear.

2. Now open the KMOS workflow by clicking on File -> Open File, selecting first kmos-1.3.11
and then the file kmos.xml in the file browser. You will be presented with the workflow canvas shown
in Figure 5.2. Note that the workflow will appear as a canvas in a new window.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlight-
ing. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the
animation interval (100 ms is recommended), and click OK .

4. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important direc-
tories (green dots). Setting the value of ROOT_DATA_DIR is the only necessary modification if you want
to process data other than the demo data5, since the value of this parameter specifies the working direc-
tory within which the other directories are organised. Double-click on the parameter ROOT_DATA_DIR
and a pop-up window will appear allowing you to modify the directory string, which you may either edit
directly, or use the Browse button to select the directory from a file browser. When you have finished,
click OK to save your changes.

5If you used the install script install_reflex, then the value of the parameter ROOT_DATA_DIR will already be set correctly
to the directory where the demo data was downloaded.
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5. Click the button to start the workflow

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data directory
(specified by the parameter RAWDATA_DIR under “Setup Directories” in the workflow canvas) and con-
structs the DataSets. Note that the raw and static calibration data must be present either in RAWDATA_DIR
or in CALIB_DATA_DIR, otherwise DataSets may be incomplete and cannot be processed. However,
if the same reference file was downloaded twice in different places this creates a problem as Reflex
cannot decide which one to use.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window
(see Figure 5.3) that lists the DataSets along with the values of a selection of useful header keywords6.
The first column consists of a set of tick boxes which allow the user to select the DataSets to be processed,
and by default all complete DataSets are selected.

8. Click the Continue button and watch the progress of the workflow by following the red highlighting
of the actors. A window will show which DataSet is currently being processed.

9. When the reduction of the current DataSet finishes, a pop-up window called Provenance Explorer will
appear showing the datasets which have been so far reduced together with the list of final products. This
actor allows the user to inspect the final data products, as well as to search and inspect the input data used
to create any of the products of the workflow. Figure 5.4 shows the Provenance Explorer window.

10. The workflow will continue with the remaining DataSets following the same steps described above.

11. After the workflow has finished, all the products from all the DataSets can be found in a directory under
END_PRODUCTS_DIR with the named with the workflow start timestamp. Further subdirectories will
be found with the name of each DataSet.

Well done! You have successfully completed the quick start section and you should be able to use this knowledge
to reduce your own data. However, there are many interesting features of Reflex and the KMOS workflow
that merit a look at the rest of this tutorial.

6The keywords listed can be changed by right-clicking on the DataOrganiser Actor, selecting Configure Actor, and then
changing the list of keywords in the second line of the pop-up window.
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Figure 5.2: KMOS workflow general layout.

Figure 5.3: The “Select Datasets” pop-up window.
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Figure 5.4: The KMOS provenance explorer.
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6 Reducing Science Verification Data

To reduce science verification data, simply change the path to the raw data directory defined at the top of
the workflow labelled Setup Directories by double clicking on RAW_DATA_DIR. Then just re-run the
workflow as for the tutorial demo data.
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7 KMOS Reduced Data Description

A number of intermediate pipeline products from the tutorial data set can be found in subdirectories of the
TMP_PRODUCT_DIR. These master calibration files are summarized in table 7.1.

Table 7.1: The KMOS Reflex workflow tutorial data set: calibration products

File PRO.CATG Description
kmos_dark:
badpixel_dark.fits BADPIXEL_DARK preliminary bad pixel map (hot pixels)
master_dark.fits MASTER_DARK master dark frame including a noise map

kmos_flat:
badpixel_flat_KKK.fits BADPIXEL_FLAT master bad pixel map (hot + cold pixels)
flat_edge_KKK.fits FLAT_EDGE fits table defining the edges of each IFU pseudo slit as derived from the screen flat frames
master_flat_KKK.fits MASTER_FLAT master flat-field frame including noise map
xcal_YJYJYJ.fits XCAL spatial solution lookup frame
ycal_YJYJYJ.fits YCAL spatial solution lookup frame

kmos_wave:
det_img_wave_KKK.fits DET_IMG_WAVE resampled image of reconstructed arc frame
lcal_KKK.fits LCAL wavelength solution lookup frame

kmos_illum:
illum_corr_KKK.fits ILLUM_CORR illumination correction to flat-filed
skyflat_edge_KKK.fits SKYFLAT_EDGE fits table defining the edges of each pseudo slit IFU as derived from the sky flat frames

kmos_std:
star_spec_KKK.fits STAR_SPEC extracted star spectrum
std_image_KKK.fits STD_IMAGE collapsed standard star cube image
std_mask_KKK.fits STD_MASK masked pixels within the collapsed standard star cube image
telluric_KKK.fits TELLURIC normalized telluric spectrum including noise map

The final products of the reduction pipeline can be found in the directory END_PRODUCT_DIR that is defined
in the “Setup Directories” section at the top of the workflow.

The science data products from the tutorial data set are summarized in table 7.2.
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Table 7.2: The KMOS Reflex workflow science products from the tutorial data set (all K-band)

File PRO.CATG Description
SCI-GUM43_MAKE_IMAGE.fits MAKE_IMAGE the median collapse of the IFU #1 data cube along the wavelength direction.
SCI-GUM43_MAKE_IMAGE_1.fits MAKE_IMAGE the median collapse of the IFU #2 data cube along the wavelength direction.
SCI-GUM43_MAKE_IMAGE_2.fits MAKE_IMAGE the median collapse of the IFU #3 data cube along the wavelength direction.
SCI-GUM43_MAKE_IMAGE_3.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_4.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_5.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_6.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_7.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_8.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_9.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_10.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_11.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_12.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_13.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_14.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_15.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_16.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_17.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_18.fits MAKE_IMAGE ". Only 19 IFU’s were active in this OB.

SCI-GUM43_SCI_COMBINED.fits SCI_COMBINED reconstructed science cube (coadded dithers) including noise map created from IFU #1.
SCI-GUM43_SCI_COMBINED_1.fits SCI_COMBINED reconstructed science cube (coadded dithers) including noise map created from IFU #2.
SCI-GUM43_SCI_COMBINED_2.fits SCI_COMBINED reconstructed science cube (coadded dithers) including noise map created from IFU #3.
SCI-GUM43_SCI_COMBINED_3.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_4.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_5.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_6.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_7.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_8.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_9.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_10.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_11.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_12.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_13.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_14.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_15.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_16.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_17.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_18.fits SCI_COMBINED ". Only 19 IFU’s were active in this OB.

SCI-GUM43_SCI_RECONSTRUCTED.fits SCI_RECONSTRUCTED intermediate reconstructed and combined science cube including noise map for pointing #1.
SCI-GUM43_SCI_RECONSTRUCTED_1.fits SCI_RECONSTRUCTED intermediate reconstructed and combined science cube including noise map for pointing #2.
SCI-GUM43_SCI_RECONSTRUCTED_2.fits SCI_RECONSTRUCTED intermediate reconstructed and combined science cube including noise map for pointing #3.
SCI-GUM43_SCI_RECONSTRUCTED_3.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_4.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_5.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_6.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_7.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_8.fits SCI_RECONSTRUCTED "
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8 About The Reflex Canvas

8.1 Saving And Loading Workflows

In the course of your data reductions, it is likely that you will customise the workflow for various data sets, even
if this simply consists of editing the ROOT_DATA_DIR to a different value for each data set. Whenever you
modify a workflow in any way, you have the option of saving the modified version to an XML file using File
-> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved
workflow may be opened in subsequent Reflex sessions using File -> Open. Saving the workflow in the
default format (.kar) is only advised if you do not plan to use the workflow in another computer.

8.2 Buttons

At the top of the Reflex canvas are a set of buttons which have the following useful functions:

• - Zoom in.

• - Reset the zoom to 100%.

• - Zoom the workflow to fit the current window size (Recommended).

• - Zoom out.

• - Run (or resume) the workflow.

• - Pause the workflow execution.

• - Stop the workflow execution.

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

8.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the

yellow highlighting of the , , and buttons, respectively. A workflow is executed by clicking the
button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the

button, or the workflow may be paused by clicking the button which will allow the current actor/recipe
to finish execution before the workflow is actually paused. After pausing, the workflow may be resumed by

clicking the button again.
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9 The KMOS Workflow

The KMOS workflow canvas is organised into a number of areas. From top-left to top-right you will find
general workflow instructions, directory parameters, and global parameters. In the middle row you will find five
boxes describing the workflow general processing steps in order from left to right, and below this the workflow
actors themselves are organised following the workflow general steps.

9.1 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user. Under “Setup Directories” the
user is only required to set the RAWDATA_DIR to the working directory for the DataSet(s) to be reduced, which,
by default, is set to the directory containing the demo data. The RAWDATA_DIR is recursively scanned by the
Data Organiser actor for input raw data. The directory CALIB_DATA_DIR, which is by default within
the pipeline installation directory, is also scanned by the Data Organiser actor to find any static calibrations
that may be missing in your DataSet(s). If required, the user may edit the directories BOOKKEEPING_DIR,
LOGS_DIR, TMP_PRODUCTS_DIR, and END_PRODUCTS_DIR, which correspond to the directories where
book-keeping files, logs, temporary products and end products are stored, respectively (see the Reflex User
Manual for further details; [4]).

Under the “Global Parameters” area of the workflow canvas, the user may set the FITS_VIEWER parameter to
the command used for running his/her favourite application for inspecting FITS files. Currently this is set by
default to fv, but other applications, such as ds9, skycat and gaia for example, may be useful for inspecting
image data.

By default the EraseDirs parameter is set to false, which means that no directories are cleaned before
executing the workflow, and the recipe actors will work in Lazy mode (see Section 9.2.2), reusing the previous
pipeline recipe outputs where input files and parameters are the same as for the previous execution, which saves
considerable processing time. Sometimes it is desirable to set the EraseDirs parameter to true, which
forces the workflow to recursively delete the contents of the directories specified by BOOKKEEPING_DIR,
LOGS_DIR, and TMP_PRODUCTS_DIR. This is useful for keeping disk space usage to a minimum and will
force the workflow to fully rereduce the data each time the workflow is run.

The parameter RecipeFailureMode controls the behaviour in case that a recipe fails. If set to Continue,
the workflow will trigger the next recipes as usual, but without the output of the failing recipe, which in most
of the cases will lead to further fails of other recipes without the user actually being aware of it. This mode
might be useful for unattended processing of large number of datasets. If set to Ask, a pop-up window will ask
whether the workflow should stop or continue. This is the default. Additionally, the Stop mode will stop the
workflow execution immediately.

The parameter GlobalInteractivity controls whether the interactive windows will appear for those win-
dows which are enabled by default. The possible values are true, false. Take into account that some
windows are disabled in the default configuration and therefore are not affected by this parameter.

The parameter ProvenanceExplorerEnabled controls whether the ProvenanceExplorer actor will
show its window or not. The possible values are true, false.
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9.2 Workflow Actors

9.2.1 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They
may also have a logo within the rectangle to aid in their identification. The following actors are simple actors:

• - The Data Organiser actor.

• - The Data Set Chooser actor.

• - The Fits Router actor

• - The Product Renamer actor.

• - The Provenance Explorer actor.

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting Configure
Actor. This will open an “Edit parameters” window. Note that the Product Renamer actor is a jython
script (Java implementation of the Python interpreter) meant to be customised by the user (by double-clicking
on it).

9.2.2 Lazy Mode

By default, all recipe executer actors in a pipeline workflow are “Lazy Mode” enabled. This means that when
the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has
already been executed with the same input files and with the same recipe parameters. If this is the case, then the
actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products
to the output port. The purpose of the Lazy mode is therefore to minimise any reprocessing of data by avoiding
data rereduction where it is not necessary.

One should note that the actor Lazy mode depends on the contents of the directory specified by
BOOKKEEPING_DIR and the relevant FITS file checksums. Any modification to the directory contents and/or
the file checksums will cause the corresponding actor when executed to run the pipeline recipe again, thereby
rereducing the input data.

The forced rereduction of data at each execution may of course be desirable. To force a rereduction of all data
for all RecipeExecuter actors in the workflow (i.e. to disable Lazy mode for the whole workflow), set the
EraseDirs parameter under the “Global Parameters” area of the workflow canvas to true. This will then
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remove all previous results as well. To force a rereduction of data for any single RecipeExecuter actor
in the workflow (which will be inside the relevant composite actor), right-click the RecipeExecuter actor,
select Configure Actor, and uncheck the Lazy mode parameter tick-box in the “Edit parameters” window
that is displayed. If the Lazy mode is switched off for an actor, all subsequent actors that use products from that
one will also reprocess the data, as they see new products.
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10 Optimising Your Results Through Workflow Interaction

In this section, we use the information from section 5 along with the KMOS demo data supplied with Reflex2.6
to illustrate how to optimise the scientific products in terms of quality and S/N. This is work in progress and
the contents of this section will grow as we gain experience and add functionality. Optimising the results is
achieved by interaction with the workflow actors via interactive windows displayed at key data reduction points
in the data flow, which enable iteration of certain recipes in order to obtain better results.

We recommend that the user has already carried out the reductions for all demo DataSets as described in Sec-
tion 5, although this is not a pre-requisite to following this section. By doing this, the user will be taking
advantage of the workflow Lazy Mode, with minimal waiting time between various pipeline recipe executions.

Please follow these steps in order to optimise the reductions for the KMOS demo data:

1. Carry out the first four steps described in the Quick Start Section 5.

2. In the KMOS workflow, the interactive actor Wavelength Calibration (WAVE_CAL) is identi-
fiable by an orange rectangle encompassing the actor name. The interactive mode is enabled by default.
Should you wish to change that use Open Actor to get access to the the components of the interactive
actors, then double-click on the composite actors, setting the “EnableInteractivity” parameter to false,
and clicking Commit to save the changes to the workflow.

3. Wavelength Calibration: Figure 10.1 shows the interactive window that will pop-up at the end
of the execution of the kmo_wave_cal pipeline routine. The image panels at the top of the window show
the reconstructed arc frames for each of the three detectors at one of the six rotator position angles. To
view the reconstructed arc frames at another rotator angle (either 0, 60, 120, 180, 240, or 300 degrees),
simply click on the ovals in the Angle selection box. For each of the 18 reconstructed arc frames, the
relative average offset of the reconstructed arc lines are plotted in units of pixels for each of the Argon
and Neon arc lines (bottom two plots). One-half of the length of the error bars associated with each data
point gives the average FWHM (in pixels) for each arc line.

On the right-hand edge of the interactive window the user may modify a number of parameters to improve
the wavelength calibration. The parameters and their description is given in table 10.1. If parameters
have been changed, then clicking on the Re-run Recipe will re-exectute the kmo_wave_cal pipeline
routine.
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Figure 10.1: The interactive window for the Wavelength Calibration actor as displayed for the KMOS
tutorial data set..

Table 10.1: Parameters that a user can manipulate within the WAVE_CAL interactive window
Parameter1 Value (default) Explanation
–order 0 The polynomial order to use for the fit of the wavelength solution.

The appropriate order is chosen automatically depending on the waveband.

Otherwise an order of 6 is recommended, except for IZ-band, there order 4 should be used

–dev_flip FALSE Set this parameter to TRUE if the wavelengths are ascending on the detector from top to bottom

–dev_disp -1 The expected dispersion of the wavelength in microns/pixel.

If the default is not changed it will automatically be selected upon header keywords

–suppress_extension FALSE Suppress arbitrary filename extension. (if TRUE (apply) or FALSE (do not apply)

–b_samples 2048 The number of samples in wavelength for the reconstructed cube

–b_start -1 The lowest wavelength [µm] to take into account when reconstructing

(default of -1 sets the proper value for the actual band automatically)

–b_end -1 The highest wavelength [µm] to take into account when reconstructing

(default of -1 sets the proper value for the actual band automatically)
1 All parameters, available to the kmo_wave_cal pipeline routine, have been included for use in the WAVE_CAL interactive window.
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4. Telluric Standard Star Calibration: Figure 10.2 shows the interactive window that will
pop-up at the end of the execution of the kmo_std_star pipeline routine. The image panel at the top-right
of the window shows the median collapsed data cube (pipeline product: STD_IMAGE) For a single IFU.
The total number of IFU’s dedicated to observing a telluric standard star are listed to the left of this image
and clicking on the circle will display the standard star from another IFU. For the tutorial data set only
IFU #3 and IFU #12 observed standard stars.

At the bottom of the interactive window the extracted standard star spectrum (for the selected IFU) is
displayed (pipeline product: STAR_SPEC) in flux units of ADU and wavelength units of microns.

On the right-hand edge of the interactive window the user may modify a number of parameters to improve
the telluric standard star calibration. The parameters and their description is given in table 10.2. If pa-
rameters have been changed, then clicking on the Re-run Recipe will re-exectute the kmo_std_star
pipeline routine.

Figure 10.2: The interactive window for the Telluric Standard Star Calibration actor as dis-
played for the KMOS tutorial data set..
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Table 10.2: Parameters that a user can manipulate within the STD_STAR interactive window

Reconstruction
Parameter1 Value (default) Explanation
–imethod CS The interpolation method used for reconstructing the standard star data cube.

A Cubic-spline (CS) interpolation is used as the default. Note that no error spectra will be generated for this interpolation method.

The full list of interpolation methods include:

CS: Cubic-spline

NN: Nearest Neighbour

lwNN: linear-weighted Nearest Neighbour

swNN: square-weighted Nearest Neighbour

MS: modified Shepard’s method

–xcal_interpolation TRUE If TRUE interpolate the pixel position in the slitlet (xcal) using the two closest rotator angles in the calibration file.

Otherwise take the values of the closest rotator angle.

–b_samples 2048 The number of samples in wavelength for the reconstructed cube

–b_start -1 The lowest wavelength [µm] to take into account when reconstructing

(default of -1 sets the proper value for the actual band automatically)

–b_end -1 The highest wavelength [µm] to take into account when reconstructing

(Default of -1 sets the proper value for the actual band automatically)

Extraction
–fmethod gauss The type of function that should be fitted spatially to the collapsed image.

This fit is used to create a mask to extract the spectrum of the object.

The full list of fitting methods include:

gauss

moffat

–neighborhoodRange 1.001 Defines the range to search for neighbors during reconstruction.

–flux FALSE Apply conservation of flux (TRUE/FALSE).

Combination
–cmethod ksigma The method of frame combination to be used.

ksigma is an iterative sigma clipping. For each position all pixels in the spectrum

are examined. If they deviate significantly, they will be rejected according to the conditions:

val> mean + stdev * cpos_rej and val< mean - stdev * cneg_rej

The full list of combination methods include:

ksimga: kappa-sigma clipping

median: at each pixel position the median is calculated

average: at each pixel position the average is calculated

sum: at each pixel position the sum is calculated

min-max: The specified number of minimum and maximum pixel values will be rejected. –cmax and –cmin apply to this method

–cpos_rej & –cneg_rej 3.0 & 3.0 The positive and negative rejection thresholds for bad pixels.

–citer 3 The number of iterations for kappa-sigma-clipping (applies only when –cmethod = ksigma).

–cmax & –cmin 1 & 1 The number of maximum and minimum pixel values to clip with min/max-clipping (applies only when –cmethod = min_max).

Star
–startype FALSE If this parameter is specified, the stored star types of the observed objects in the FITS headers are overridden.

This value applies to all objects examined in the input frames.

Examples could be A3I, G3IV or K0I.

The first letter defines the star type, the second letter the spectral class and the last letters the luminosity class.

–magnitude FALSE If this parameter is specified, the stored magnitudes in the FITS headers are overridden.

For HK two magnitudes for each H and K have to be specified (separated by a comma). All other gratings use a single magnitude.
1 All parameters, available to the kmo_std_star pipeline routine, have been included for use in the STD_STAR interactive window.
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5. Science Reduction: Figure 10.3 shows the interactive window that will pop-up at the end of the
execution of the kmo_sci_red pipeline routine.

The selection panel at the top of the window shows the list of individual reconstructed science images
(pipeline products: SCI_RECONSTRUCTED) in the processed data set. Each file can be selected by
clicking on the oval with the left mouse button.

The central selection panel summarizes the status of each individual IFU for the selected frame. IFU’s for
which an extracted spectrum can be viewed are shown as Active And are plotted in green. The other
IFU statuses, in Collision, NotInPAF, Locked, and NotInPAF&Locked are shown in cyan, blue,
black, and red, respectively. These IFU’s cannot be selected. To select an Active IFU the user should
use the centre mouse button. The selected IFU is then shown with a bar beneath its numbered box.

At the bottom of the interactive window the extracted science frame spectrum (for the selected IFU) is
displayed in flux units of ADU and wavelength units of microns. The flux is shown as a blue line, while
the associated error is given in red. Currently, the extracted spectrum is derived in the python script of the
interactive window. Each 14×14 pixel plane of the science data cube is averaged and plotted as a function
of wavelength.

On the right-hand edge of the interactive window the user may modify a number of parameters to improve
the science frame reduction. The parameters and their description is given in table 10.3. If parameters
have been changed, then clicking on the Re-run Recipe will re-exectute the kmo_sci_red pipeline
routine.
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Figure 10.3: The interactive window for the Science Reduction actor as displayed for the KMOS tutorial data
set..
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Table 10.3: Parameters that a user can manipulate within the SCI_RED interactive window

Reconstruction
Parameter1 Value (default) Explanation
–imethod CS The interpolation method used for reconstructing the science data cube.

A Cubic-spline (CS) interpolation is used as the default. Note that no error spectra will be generated for this interpolation method.

The full list of interpolation methods include:

CS: Cubic-spline

NN: Nearest Neighbour

lwNN: linear-weighted Nearest Neighbour

swNN: square-weighted Nearest Neighbour

MS: modified Shepard’s method

–xcal_interpolation TRUE If TRUE interpolate the pixel position in the slitlet (xcal) using the two closest rotator angles in the calibration file.

Otherwise take the values of the closest rotator angle.

–b_samples 2048 The number of samples in wavelength for the reconstructed cube

–b_start -1 The lowest wavelength [µm] to take into account when reconstructing (the default of -1 sets the proper value for the actual band automatically).

–b_end -1 The highest wavelength [µm] to take into account when reconstructing (the default of -1 sets the proper value for the actual band automatically).

Extraction
–fmethod gauss The type of function that should be fitted spatially to the collapsed image.

This fit is used to create a mask to extract the spectrum of the object.

The full list of fitting methods include: gauss and moffat

–neighborhoodRange 1.001 Defines the range to search for neighbors during reconstruction.

–flux FALSE Apply conservation of flux (TRUE/FALSE).

Combination
–cmethod ksigma The method of frame combination to be used. ksigma is an iterative sigma clipping.

For each position all pixels in the spectrum are examined. If they deviate significantly, they will be rejected according to the conditions:

val> mean + stdev * cpos_rej and val< mean - stdev * cneg_rej

The full list of combination methods include:

ksimga: kappa-sigma clipping

median: at each pixel position the median is calculated

average: at each pixel position the average is calculated

sum: at each pixel position the sum is calculated

min-max: The specified number of minimum and maximum pixel values will be rejected. –cmax and –cmin apply to this method

–cpos_rej & –cneg_rej 3.0 & 3.0 The positive and negative rejection thresholds for bad pixels.

–citer 3 The number of iterations for kappa-sigma-clipping (applies only when –cmethod = ksigma).

–cmax & –cmin 1 & 1 The number of maximum and minimum pixel values to clip with min/max-clipping (applies only when –cmethod = min_max).

Other
–smethod FALSE The interpolation method used for shifting. The full list of shifting methods include:

CS: cubic spline

NN: nearest neighbour

–background FALSE Specify if a background subtraction should be applied.

–pix_scale 0.2 Change the pixel scale (in arcsec).

The default value of 0.2 arcsec results in cubes of size 14×14 pixels, while a scale of 0.1 arcsec would results in cubes of 28×28 pixels, etc.

–no_subtract FALSE If set to TRUE, the found objects and references will not be sky subtracted.

Additionally all IFUs will be reconstructed, even the ones containing skies. This option sets the parameter no_combine to TRUE automatically.

–ifus The indices of the IFUs to combine. The number of entries has to match the number of input frames.

For example, to combine IFUs number 1, 5, 12, and 21 this parameter should be set to: 1;5;12;21

–method header The shifting method to use. The full list of shifting methods include:

header: the shifts are calculated according to the WCS information stored in the header of each IFU.

none: the cubes are directly recombined, with no shifts applied.

center: the shifts are calculated using a centering algorithm.

user: the shifts are read from a user specified file. The path of the file must be provided using the –filename parameter.

–filename When using the –method user (see above), specify the path name to the file with the shift vectors.
1 Only the most important parameters, available to the kmo_sci_red pipeline routine, have been included for use in the SCI_RED interactive window.
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6. For each of the three interactive windows described above, the panel of buttons at the very top-left of the
window may be used to manipulate the displayed plots. The buttons have the following functions:

• - Reset all the plot ranges to their original values.

• - Undo the last modification of the plot ranges (if possible).

• - Redo the next modification of the plot ranges (if possible).

• - Selecting this button allows the user to use the mouse to shift the plot ranges by left-clicking
on the target plot canvas and then dragging the mouse around while keeping the left mouse button
held down, and releasing when ready.

• - Selecting this button allows the user to zoom in on each plot by left-clicking on the target plot
canvas to mark the top-left corner of a rectangle and then dragging the mouse to the bottom-right
corner of the rectangle and releasing. The plot ranges will then be modified to match the rectangle
that was defined. The following constraints can be made by holding simultaneously a key while
pressing the left mouse button:

Constrain pan/zoom to x axis hold X
Constrain pan/zoom to y axis hold Y
Preserve aspect ratio hold Ctrl

• - Clicking this button opens a “Configure subplots” window that allows the user to adjust the
spacing and positioning of the individual plots.

• - Clicking this button opens a “Save to file” window which allows the user to save a screenshot
of the current interactive window.

• - Clicking this button allows the user to change the display levels of the 2-dimensional merged
image by clicking on pixels within the 2-dimensional image (similar to ds9).

Use these buttons to inspect the plots in the interactive window in more detail.

7. Once the user is satisfied with the results, then clicking on the Continue Wkf button will continue
with the rest of the workflow.

8. As noted in the Quick Start Section 5, the workflow will then proceed through its remaining process-
ing steps and write out all pipeline products to the end products directory (specified by the parameter
END_PRODUCTS_DIR under “Setup Directories” in the workflow canvas). The science data products
from the tutorial data set are summarized in section 7 in table 7.2. The intermediate pipeline calibration
products can be found in subdirectories of the TMP_PRODUCT_DIR and are summarized in section 7 and
in table 7.1.
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11 Frequently Asked Questions

• Where are my intermediate pipeline products? Intermediate pipeline products are stored in the direc-
tory <TMP_PRODUCTS_DIR> (defined on the workflow canvas) and organised further in directories by
pipeline recipe.

• Can I use different sets of bias frames to calibrate my flat frames and science data? Yes. In fact this
is what is currently implemented in the workflow(s). Each file in a DataSet has a purpose attached to it
([4]). It is this purpose that is used by the workflow to send the correct set of bias frames to the recipes
for flat frame combination and science frame reduction, which may or may not be the same set of bias
frames in each case.

• Can I run Reflex from the command line? Yes, use the command:

reflex -n <workflow_path>/<workflow>.xml

The -n option will set all the different options to Kepler and the workflows that avoid any graphical display
(including pipeline interactive windows). Note that this mode is not fully supported, and the user should
be aware that the path to the workflow must be absolute and even if no GUI elements are shown, it still
requires a connection to the window manager.

• How can I add new actors to an existing workflow? You can drag and drop the actors in the menu
on the left of the Reflex canvas. Under Eso-reflex -> Workflow you may find all the actors
relevant for pipeline workflows, with the exception of the recipe executer. This actor must be manu-
ally instantiated using Tools -> Instantiate Component. Fill in the “Class name” field with
org.eso.RecipeExecuter and in the pop-up window choose the required recipe from the pull-
down menu. To connect the ports of the actor, click on the source port, holding down the left mouse
button, and release the mouse button over the destination port. Please consult the Reflex User Manual
([4]) for more information.

• How can I broadcast a result to different subsequent actors? If the output port is a multi-port (filled
in white), then you may have several relations from the port. However, if the port is a single port (filled in
black), then you may use the black diamond from the toolbar. Make a relation from the output port to the
diamond. Then make relations from the input ports to the diamond. Please note that you cannot click to
start a relation from the diamond itself. Please consult the Reflex User Manual ([4]) for more information.

• How can I run manually the recipes executed by Reflex? If a user wants to re-run a recipe on the
command line he/she has to go to the appropriate reflex_book_keeping directory, which is generally
reflex_book_keeping/<workflow>/<recipe_name>_<number> There, subdirectories exist with the time
stamp of the recipe execution (e.g. 2013-01-25T12:33:53.926/). If the user wants to re-execute the most
recent processing he/she should go to the latest directory and then execute the script cmdline.txt.
Alternatively, to ensure that the path to esorex is the correct one, the user can execute

ESOREX_CONFIG="INSTALL_DIR/etc/esorex.rc"
INSTALL_DIR/bin/esorex --recipe-config=<recipe>.rc <recipe> data.sof
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where INSTALL_DIR is the directory where Reflex and the pipelines were installed.

If a user wants to re-execute in the command line a recipe that used a given raw frame, the way to find the
proper data.sof in the bookkeeping directory is via grep <raw_file> */data.sof. Afterwards
the procedure is the same as before.

If a recipe is re-executed with the command explained before, the products will appear in the directory
from which the recipe is called, and not in the reflex_tmp_products or reflex_end_products directory, and
they will not be renamed. This doesn’t happen if you use the cmdline.txt script.
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12 Troubleshooting

Figure 12.1: TheDataOrganizer interactive window reports an error “:No DataSets have been created, check
the data set and the OCA rules.”.

1. I downloaded the data from the ESO archive, put them into a new directory, tried to run Reflex
on them, but

(a) it crashs
This may happen if one of the files was downloaded only partially (check for a file with the extension
fits.Z.part. You will have to download that file again in order to have an uncorrrupted file (and
remove the partial one).

(b) it fails with error message “:No DataSets have been created, check the data set and the OCA
rules.”(see Figure 12.1.)
This error may be due to the fact that the data provided by the ESO archive are compressed
(<filename>.fits.Z). Please remember to uncompress the data before executing Reflex.

(c) all DataSets are greyed out in the DataSets interactive window.
The ESO archive used with CalSelector does not always supply all static calibration files. As a
consequence some/all DataSets are greyed out because they were missing such required data.
Missing static calibration should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal.

2. The “Select DataSets” window displays my DataSets, but some/all of them are greyed out. What is
going on?

If a DataSet in the “Select DataSets” window is greyed out, then it means that the DataSet that was con-
structed is missing some key calibration(s) (i.e. the DataSet is incomplete). To find out what calibration(s)
are missing from a greyed out DataSet, click on the DataSet in question to highlight it in blue, and then
click on the button Inspect Highlighted . The “Select Frames” window that appears will report
the category of the calibration products that are missing (e.g. MASTER_BIAS). From this the user has
then to determine the missing raw data (in this case bias frames). If static calibrations are missing the
mechanism unfortunately does not work, but should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal
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